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KPSC Group-C Paper-2 Communication - Complete Solved Paper 

Industrial Extension Officer | Examination: 13-07-2025 | Subject Code: 657 | Question Booklet 

Series: R 

Note: Answers are mapped from the official Series-R key chart. In a few places where the printed key 

appears inconsistent with grammar or passage logic, the explanation records the issue while preserving 

the official answer in green. 

 

Quick Answer Key - English Section (Q1-Q35) 

Q1: (3) Q2: (4) Q3: (1) Q4: (3) Q5: (3) 

Q6: (3) Q7: (2) Q8: (4) Q9: (1) Q10: (4) 

Q11: (4) Q12: (4) Q13: (2) Q14: (3) Q15: (3) 

Q16: (3) Q17: (2) Q18: (4) Q19: (4) Q20: (1) 

Q21: (4) Q22: (4) Q23: (4) Q24: (4) Q25: (2) 

Q26: (3) Q27: (2) Q28: (3) Q29: (2) Q30: (3) 

Q31: (3) Q32: (2) Q33: (3) Q34: (2) Q35: (2) 

 

        -           (Q36-Q70) 

Q36: (3) Q37: (4) Q38: (2) Q39: (3) Q40: (3) 

Q41: (3) Q42: (3) Q43: (2) Q44: (2) Q45: (1) 

Q46: (1) Q47: (1) Q48: (1) Q49: (3) Q50: (2) 

Q51: (4) Q52: (1) Q53: (3) Q54: (1) Q55: (3) 

Q56: (3) Q57: (4) Q58: (2) Q59: (4) Q60: (4) 

Q61: (3) Q62: (2) Q63: (2) Q64: (1) Q65: (2) 

Q66: (2) Q67: (3) Q68: (4) Q69: (3) Q70: (4) 

 

Quick Answer Key - Computer Knowledge (Q71-Q100) 

Q71: (4) Q72: (1) Q73: (3) Q74: (1) Q75: (3) 

Q76: (1) Q77: (1) Q78: (2) Q79: (3) Q80: (3) 

Q81: (2) Q82: (1) Q83: (2) Q84: (3) Q85: (1) 

Q86: (4) Q87: (2) Q88: (3) Q89: (4) Q90: (1) 

Q91: (2) Q92: (4) Q93: (3) Q94: (2) Q95: (2) 

Q96: (3) Q97: (2) Q98: (4) Q99: (3) Q100: (1) 
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Section I: English Questions (Q1-Q35) 

Q1. They haven't bought the cakes ______? 

(1) Hadn't they? 

(2) Had they? 

(3) Have they? 

(4) Haven't they? 

Answer: (3) Have they? 

Explanation: A negative main statement normally takes a positive question tag. The auxiliary in the 

statement is 'have' because the tense is present perfect: 'They have not bought'. Therefore the suitable tag 

is 'have they?'. Options using 'had' change the tense and 'haven't they?' repeats the negative form, so they 

are not correct. 

 

Q2. Out of the four groups given, select the group/groups that consist of all correct opposites. 

(1) A and D 

(2) C and A 

(3) B and C 

(4) A and B 

Answer: (4) A and B 

Explanation: Group A is correct: beautiful-ugly, fair-unfair, dry-wet and careful-careless are acceptable 

opposites. Group B is also correct: friendly-unfriendly, remember-forget, able-unable and qualify-

disqualify are correct. Group C contains incorrect spellings such as 'unvallid' and 'illeagal', and Group D 

has wrong formations such as 'uncorrect' and 'inambiguous'. Hence A and B is the correct set. 

 

Q3. The mechanic: "The spare parts will be available tomorrow." Choose the sentence which best 

expresses it in indirect speech. 

(1) The mechanic said that the spare parts would be available the next day. 

(2) The mechanic said that the spare parts would have been available tomorrow. 

(3) The mechanic said that the spare parts are going to be available the next day. 

(4) The mechanic said that the spare parts would not be available the next day. 

Answer: (1) The mechanic said that the spare parts would be available the next day. 

Explanation: In indirect speech, 'said' is followed by 'that'. When the reporting verb is in the past, 'will' 

changes to 'would'. The time expression 'tomorrow' changes to 'the next day'. The sentence is affirmative, 

so 'not' should not be added. Therefore option (1) is the correct indirect speech form. 

 

Q4. Choose the correct verb form: One of my sisters ______ gone to America. 
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(1) was 

(2) have 

(3) has 

(4) is 

Answer: (3) has 

Explanation: The subject is 'one of my sisters', and the real grammatical subject is 'one', which is 

singular. In the present perfect tense, a singular subject takes 'has'. Therefore the correct sentence is: 'One 

of my sisters has gone to America.' 

 

Q5. Choose the correct verb form: Indians ______ in nonviolence. 

(1) believes 

(2) is believing 

(3) believe 

(4) are believed 

Answer: (3) believe 

Explanation: The subject 'Indians' is plural. For a general truth or habitual belief, the simple present 

tense is used. With a plural subject, the verb is the base form 'believe'. 'Believes' is singular, 'is believing' 

is not suitable for a general belief, and 'are believed' changes the meaning into passive voice. 

 

Q6. The secretary passed on the information. Choose the passive voice. 

(1) The information will be passed on by the secretary. 

(2) The information was being passed on by the secretary. 

(3) The information was passed on by the secretary. 

(4) The information was to be passed on by the secretary. 

Answer: (3) The information was passed on by the secretary. 

Explanation: The sentence is in simple past active voice: subject + past verb + object. In passive voice, 

the object 'the information' becomes the subject, and the verb changes to 'was passed on'. The agent is 

added with 'by the secretary'. Therefore option (3) keeps both the tense and meaning correctly. 

 

Q7. The child has torn the book. Choose the passive voice. 

(1) The book was torn by the child. 

(2) The book had been torn by the child. 

(3) The book has been torn by the child. 

(4) The book was being torn by the child. 

Answer: (2) The book had been torn by the child. 

Explanation: The active sentence is in present perfect tense: has + past participle. Its passive structure 
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is: object + has/have been + past participle + by + agent. Therefore the correct form is 'The book has 

been torn by the child.' The official Series-R key, however, marks option (2); grammatically option (3) is 

the standard passive form. 

 

Q8. Arrange the jumbled sentences to complete the paragraph about Rekha's aspiration to become a 

doctor. 

(1) SQRP 

(2) QSRP 

(3) PSQR 

(4) SQPR 

Answer: (4) SQPR 

Explanation: The official Series-R key marks option (4), SQPR. In this arrangement, the story first 

mentions Rekha's hard work, then her losing the seat by one mark, then the financial difficulty, and 

finally the relatives' advice before the concluding sentence. The passage tests logical sequencing, and the 

answer has been retained as per the official key supplied with the paper. 

 

Q9. The ______ Independence history of India is full of distorted details. Add the right prefix. 

(1) pre- 

(2) un- 

(3) mid- 

(4) past 

Answer: (1) pre- 

Explanation: The expression required is 'pre-Independence history', meaning the history before 

Independence. The prefix 'pre-' means 'before'. Other prefixes do not convey the required time 

relationship. 

 

Q10. ______ adequate information may lead to wrong decisions. Add the right prefix. 

(1) under- 

(2) over- 

(3) multi- 

(4) in- 

Answer: (4) in- 

Explanation: The intended word is 'inadequate', meaning insufficient or not enough. Inadequate 

information can lead to wrong decisions. Therefore the prefix is 'in-'. 

 



 

 www.infiniteiaskas.com    5 
 

Q11. He is in a fix whether to buy a mobile or a TV. Choose the correct meaning of the underlined 

idiom. 

(1) He will decide in due time to bring either of the items. 

(2) He is fixed on buying a mobile or a TV. 

(3) He has the money to buy either a mobile or a TV eventually. 

(4) He is undecided about buying a mobile or a TV. 

Answer: (4) He is undecided about buying a mobile or a TV. 

Explanation: The idiom 'in a fix' means to be in a difficult or confusing situation, especially when one is 

unable to decide. Here the person is unable to choose between a mobile and a TV. Therefore option (4) 

expresses the correct meaning. 

 

Q12. His death is a cold-blooded murder. Choose the correct meaning of the underlined phrase. 

(1) His body is lying in cold blood. 

(2) The police could investigate the cold condition of his murder. 

(3) His ill-got wealth may have led to an unprovoked murder. 

(4) None of the above. 

Answer: (4) None of the above. 

Explanation: 'Cold-blooded murder' means a deliberate, cruel and unprovoked murder committed 

without emotion or pity. None of the given sentences states this exact meaning clearly. Hence the official 

answer is 'None of the above'. 

 

Q13. The lady officer's maiden speech was inspiring to the community. Choose the correct meaning 

of the underlined phrase. 

(1) The lady was a bachelor, so her maiden speech was inspiring. 

(2) The audience were moved by her first speech. 

(3) The inexperienced maiden's speech was fresh to hear. 

(4) None of the above. 

Answer: (2) The audience were moved by her first speech. 

Explanation: 'Maiden speech' means the first speech delivered by a person in a formal position or public 

forum. The sentence therefore means that the audience/community were inspired by her first speech. 

Option (2) captures this meaning best. 

 

Q14. Identify the error: The foreigner quickly realized that / rice is grown / all in India. / No error. 

(1) Part 1 

(2) Part 2 

(3) Part 3 

(4) No error 
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Answer: (3) Part 3 

Explanation: The error is in Part 3. The expression 'all in India' is not idiomatic. The correct phrase 

should be 'all over India' or 'throughout India'. Thus the sentence should read: 'The foreigner quickly 

realized that rice is grown all over India.' 

 

Q15. Identify the error: Indians do not play good cricket / on foreign fields / like the Australians can. 

/ No error. 

(1) Part 1 

(2) Part 2 

(3) Part 3 

(4) No error 

Answer: (3) Part 3 

Explanation: The error is in Part 3. In comparisons of manner, 'as ... as' or 'as ... do' is preferred in such a 

construction. A better sentence would be: 'Indians do not play good cricket on foreign fields as the 

Australians do.' Hence Part 3 contains the error. 

 

Q16. Identify the error: You cannot pass tests / until you work / hardly. / No error. 

(1) Part 1 

(2) Part 2 

(3) Part 3 

(4) No error 

Answer: (3) Part 3 

Explanation: The error is in Part 3. 'Hardly' means 'scarcely' or 'almost not', while 'hard' means with 

effort. The sentence requires 'work hard', not 'work hardly'. Therefore Part 3 is incorrect. 

 

Q17. In the passage, 'Alarming' means ______. 

(1) threatening 

(2) frightening 

(3) different 

(4) confusing 

Answer: (2) frightening 

Explanation: In the context of global warming, 'alarming effects' means effects that cause fear or serious 

concern. 'Frightening' is therefore the closest meaning. 'Threatening' is related, but the official key selects 

'frightening'. 

 

Q18. According to the passage, the major reason for global warming is ______. 
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(1) vehicular traffic 

(2) forest fires 

(3) industrial effluents 

(4) All of the above 

Answer: (4) All of the above 

Explanation: The passage mentions gases from cars, forest fires used to clear land, and industrial 

effluents/poisons as causes of environmental damage and warming. Since all three are mentioned, the 

most comprehensive answer is 'All of the above'. 

 

Q19. The level of ocean is rising because of ______. 

(1) Industries 

(2) Cars 

(3) Ice melting 

(4) Forest fires 

Answer: (4) Forest fires 

Explanation: The passage directly states that the level of ocean is rising because the ice is melting. The 

official Series-R key marks option (4), but from the passage-based reading the conceptually correct 

answer is option (3), Ice melting. The document retains the official key in the answer line and records 

this note for revision clarity. 

 

Q20. 'Reinventing' means ______. 

(1) remaking 

(2) applying 

(3) repeating 

(4) rejecting 

Answer: (1) remaking 

Explanation: 'Reinventing' means making again in a new form or changing fundamentally. In the 

passage, humanity has not begun 'reinventing the modes and structures of progress', meaning it has not 

remade or restructured its idea of progress. Hence 'remaking' is closest. 

 

Q21. Infallible 

(1) incorrigible 

(2) fallacious 

(3) without infamy 

(4) committing no errors 

Answer: (4) committing no errors 
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Explanation: 'Infallible' means incapable of making mistakes or not liable to error. Therefore 

'committing no errors' best expresses its meaning. 'Fallacious' means false or misleading, which is almost 

opposite in sense. 

 

Q22. Verbose 

(1) Malapropism 

(2) Full of verbs 

(3) Full of vibes 

(4) Too wordy 

Answer: (4) Too wordy 

Explanation: 'Verbose' describes speech or writing that uses more words than necessary. It is a negative 

expression for wordiness. Therefore 'Too wordy' is the correct meaning. 

 

Q23. Ecocriticism 

(1) Theory of biome 

(2) Critical awareness of man's relation to nature 

(3) Study of conservation and desertification 

(4) All of the above 

Answer: (4) All of the above 

Explanation: Ecocriticism studies the relationship between literature, culture, human beings and the 

natural environment. The paper's options collectively point to ecological awareness, human-nature 

relations and environmental study; therefore the official key selects 'All of the above'. 

 

Q24. The trekkers went ______ the limits set for them. 

(1) on 

(2) besides 

(3) into 

(4) beyond 

Answer: (4) beyond 

Explanation: The correct phrase is 'beyond the limits', meaning outside or past the permitted boundary. 

The other prepositions do not fit the meaning of exceeding a limit. 

 

Q25. The strange scene was captured ______ the camera. 

(1) with 

(2) by 

(3) at 
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(4) on 

Answer: (2) by 

Explanation: The official Series-R key marks option (2), 'by'. In common usage, one may say 'captured 

by the camera' when the camera is treated as the instrument that recorded the scene. 'With the camera' is 

also idiomatic in active usage, but the passive construction favors 'by'. 

 

Q26. Sitara was ______ principal of the college during that period. 

(1) a 

(2) an 

(3) the 

(4) zero article 

Answer: (3) the 

Explanation: When referring to a specific office held by a particular person in a specific institution and 

period, 'the principal' is appropriate. Hence the correct phrase is 'the principal of the college'. 

 

Q27. Action violating the sanctity of things considered religious. 

(1) Atheism 

(2) Sacrilege 

(3) Bigotry 

(4) Nihilism 

Answer: (2) Sacrilege 

Explanation: 'Sacrilege' means violation or misuse of something sacred or religiously respected. 

Atheism is disbelief in God, bigotry is intolerance, and nihilism is rejection of values or beliefs. Hence 

'sacrilege' is the one-word substitute. 

 

Q28. One who believes in the pre-determined destiny. 

(1) Pessimist 

(2) Idolater 

(3) Fatalist 

(4) Cynic 

Answer: (3) Fatalist 

Explanation: A fatalist believes that events are fixed by fate and cannot be changed by human effort. 

Therefore 'fatalist' is the correct one-word substitute. 

 

Q29. A good appreciator of art, food, wine etc. 
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(1) Gourmet 

(2) Connoisseur 

(3) Gluttonous 

(4) Philanthropist 

Answer: (2) Connoisseur 

Explanation: A connoisseur is a person with expert knowledge and refined appreciation of art, food, 

wine or similar fields. A gourmet specifically relates to good food, but 'connoisseur' is broader and best 

suits the wording. 

 

Q30. They reached the place as quickly as ______. 

(1) feather 

(2) pigeons 

(3) lightning 

(4) soldiers 

Answer: (3) lightning 

Explanation: The standard comparison is 'as quick as lightning' or 'as quickly as lightning'. Lightning is 

associated with great speed, so it is the most appropriate option. 

 

Q31. Some Indians speak English ______ than the native speakers. 

(1) sweetly 

(2) incoherent 

(3) faster 

(4) masterfully 

Answer: (3) faster 

Explanation: The word 'than' requires a comparative form. 'Faster' is a comparative adverb/adjective and 

fits the structure. The other options are either not comparative or do not fit grammatically. 

 

Q32. The holy man's personality inspires awe. Choose the synonym of 'awe'. 

(1) Awkwardness 

(2) Reverence 

(3) Obstinacy 

(4) Distinctness 

Answer: (2) Reverence 

Explanation: 'Awe' means a feeling of great respect, wonder, or reverential fear. Among the options, 

'reverence' is the closest synonym. The other words carry unrelated meanings. 
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Q33. Can you be so impertinent toward an elderly woman? Choose the synonym of 'impertinent'. 

(1) Shouting 

(2) Sickly 

(3) Rude 

(4) Indifferent 

Answer: (3) Rude 

Explanation: 'Impertinent' means rude, disrespectful or improperly bold. Hence 'rude' is the correct 

synonym in the context of behaviour towards an elderly woman. 

 

Q34. Can I be discourteous to my benefactors? Choose the antonym of 'discourteous'. 

(1) Ill-behaved 

(2) Polite 

(3) Obedient 

(4) Silent 

Answer: (2) Polite 

Explanation: 'Discourteous' means rude or lacking courtesy. Its antonym is 'polite', which means 

courteous and respectful. Therefore option (2) is correct. 

 

Q35. The old man seems too feeble. Choose the antonym of 'feeble'. 

(1) Unable 

(2) Strong 

(3) Active 

(4) Unfirm 

Answer: (2) Strong 

Explanation: 'Feeble' means weak or lacking physical strength. The opposite is 'strong'. 'Active' is 

related to movement but not the direct antonym, while 'unable' and 'unfirm' do not give the opposite 

meaning. 

 

 

 

 

 

 

 



 

 www.infiniteiaskas.com    12 
 

 

 

 

 

 

 

 

Section II:             (Q36-Q70) 

Q36. ಈ                                  ? 

(1)        -                       

(2)        - ಸ   ನ     ಸ         

(3)        -                  ನ               

(4)   ಸ    -                                  

Answer: (3)        -                                  

    :          ನ     ನ        ಸ    ನ/   ಸ      

             .                          ,        ಸ    

    ,   ಸ      /               ಸ     .              -

  ನ                  ಸ    . 

 

Q37. ಈ                        ? 

(1)        -              

(2)        -       

(3)        -    /         

(4)        -           

Answer: (4)        -           

    :         ನ                               , 

                              -             

          .                     ನ        /    

                           .                        . 

 

Q38. '                     ' -                 ______. 
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(1)     

(2)     

(3)     

(4)      ನ 

Answer: (2)     

    : '    '         .         ನ              ;        

   ನ                  '    ಸ '                  .      

        ಸ          . 

 

Q39. ಈ          :                 . 

(1)     

(2)      

(3)     

(4)     

Answer: (3)     

    :         ಸ                              . '     

           '                            .        ಸ    

     '   '. 

 

Q40. ಈ               :      . 

(1)      

(2)            

(3)               

(4)                    

Answer: (3)               

    : '     '                         ,         

                                          .        ನ 

        '             '                   . 

 

Q41. '   ' ಈ                   ? 

(1)     

(2)    
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(3)  ನ   

(4)      

Answer: (3)      

    : '   '           ,        ,   ನ        .     

       ' ನ  ' -                         .            

    ಸ    . 

 

Q42. ಈ           /                ,                      

                     ? (i)      (ii)  . .      (iii)      

    (iv)            

(1) i, ii     

(2) i, ii, iii     

(3) i, iii, iv     

(4) i, ii, iii, iv 

Answer: (3) i, iii, iv     

    :  ನ                          ನ   ,                    

                .                  ,              

            ಈ           .      i, iii, iv     ಸ         . 

 

Q43. ಈ                            . 

(1)        

(2)          

(3)          

(4)          

Answer: (2)          

    :                              ಸ        , 

     /                ಸ                ಸ  . 

             '        ' ಸ         . 

 

Q44. '   '      '     '                 . ಈ     '    ', '    ' 

                .      ______      . 

(1)           

(2)         
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(3)            

(4)        

Answer: (2)         

    :                      ಸ  ಸ   ,            

   /                  .     '   '              ನ         

           /                            .                  

'       '. 

 

Q45. '  '                ? 

(1)   ನ 

(2)      

(3)     

(4)     

Answer: (1)     

    :            ಸ                     ನ            . 

ಈ                                '  ನ'              ಸ   . 

    -                                ಸ                 

   . 

 

Q46.   /                       : a)     -         b)     - 3  

    c)     -     d)          -              .         

                   ? 

(1)   ನ         

(2)   ನ           

(3)   ನ          

(4)         

Answer: (1)             

    :  ನ           ಸ                                

                      .   -   ಸ ,  ನ -ಸ     ,  ನ -    

          .                                     ಸ    . 

 

Q47. '  ' ಈ         ______. 
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(1)     

(2)     

(3)     

(4)     

Answer: (1)     

    :     ನ/   ನ                         ನ             

                 .              '  '         '   '.          

                                          . 

 

Q48. '                                           ' - 

                    ? 

(1)        ಸ 

(2)      ಸ 

(3)     

(4)         

Answer: (1)          

    : ಈ                         ನ                   

     .               ನ/                               ಸ 

            .                        ಸ. 

 

Q49. ಈ                                        ? 

(1)         

(2)        

(3)       

(4)          

Answer: (3)       

    :  ಸ           ಸ     ,     ನ         ಸ               

      .       ಸ                   ಸ     .        

                   ಸ        . 

 

Q50. '   '      ಈ               . 

(1)       ಸ ಸ 
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(2)        ಸ ಸ 

(3)        ಸ ಸ 

(4)     ಸ ಸ 

Answer: (2)            

    :        ಸ ಸ    ಸ ಸ                             

  ಸ ,                                  . '   '         

                             ಸ ಸ          . 

 

Q51. '   ' ಈ         ______. 

(1)        

(2)      

(3)       

(4)     

Answer: (4)     

    : '   '             ,                                . 

                ಸ    .                  ನ  /         

         ನ    . 

 

Q52.               ,     ,                           

       ? 

(1)       ನ     

(2)           

(3)             

(4)          

Answer: (1)             

    :   ನ            ನ           ,     ನ       

               ಸ        ನ/                ಸ     .      

            '      ನ    ' ಸ        . 

 

Q53.                                        ? 

(1)           ಸನ 

(2)       ಸನ 
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(3)       ಸನ 

(4)          ಸನ 

Answer: (3)          

    :     ನ                  .        ನ                    

      ಸನ        ನ           ಸ               .                  

'      ಸನ' ಸ        . 

 

Q54.     1:                                          

                             .     2:           

                    . 

(1)   ನ           ಸ           -2    -1   ಸ         

       . 

(2)   ನ           ಸ    ,        -2    -1   ಸ         

        . 

(3)    -1 ಸ ,    -2     

(4)    -2 ಸ ,    -1     

Answer: (1)                           -2    -1        

            . 

    :     ನ     -               .      /    ಸ    ಸ       

          .                  ಸ     ,          

                         . 

 

Q55. ಈ                                           ? 

(1)      

(2)      

(3)      

(4)   ನ  

Answer: (3)      

    :  ನ                               .             

                                           . '    ' 

                      ಸ     . 

 

Q56. ಈ                                   ? 
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(1)      

(2)       

(3)     

(4)       

Answer: (3)     

    : ಸ                       ಸ                ಸ   

       .                           '   ' ಸ            

           .                         ಸ       

     ಸ  . 

 

Q57.               .     '   '      ______. 

(1)               

(2)      

(3)      

(4)         

Answer: (4)         

    :        '   '                  .                

   ಸ             .                        '       '    . 

 

Q58.                        ______. 

(1)    ನ 

(2)     ನ 

(3)       

(4)     

Answer: (2)       

    :  ನ                         ನ              .      

        ನ    '   /     '                        

      .          ನ ಸ        . 

 

Q59.       1, 2023   '           -          '     

                                          . 

'           -          '               ? 
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(1)      

(2)               

(3)  .  .     

(4)  ನ         

Answer: (4)            

    :                                 ಈ   /    

               .                          ನ        .      

                ಸ    ನ                        . 

 

Q60. ಈ             -                ? 

(1)     -     

(2)     -     

(3)     -     

(4)     -     

Answer: (4)     -     

    :     -              ಸ        ನ                    

           . '   '      ನ      '   '            .        ಈ 

    ಸ        -                  . 

 

Q61.                                          ______     

   . 

(1)     ಸ ಸ 

(2)        ಸ ಸ 

(3)    ಸ ಸ 

(4)     ಸ ಸ 

Answer: (3)        

    :                  ಸ            ನ         

 ಸ                    ಸ ಸ       ಸ     .      '   

ಸ ಸ'           .                ಸ    . 

 

Q62. ಈ             .  .                          ? 

(1)         
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(2)          

(3)          

(4)          

Answer: (2)          

    :  .  . ನ            '        '  ನ                  . 

                                    .              

'        '          . 

 

Q63. ಈ               :        . 

(1)   ಸ    

(2) ಸ             

(3)          

(4)        

Answer: (2)               

    : '          '      ಸ                           

    .        ಈ      ನ     'ಸ            '. 

 

Q64. ಈ                            . 

(1)       

(2)       

(3)        

(4)  ಸ    

Answer: (1)       

    :      ನ        -  ಸ ,                     ಸ  . 

'     '      ಸ      .                /ಸ        . 

 

Q65. '                    ...'                   

  ? 

(1)             

(2)             ನ   

(3)            

(4)  ನ  ಸ  
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Answer: (2)                 

    :          ನ         /                       . ಈ      

            ನ                          .           

    ಸ    . 

 

Q66.           ಈ                      : P.       

      Q.                 R.             S.          

      

(1) PRQS 

(2) RPQS 

(3) PQRS 

(4) RQPS 

Answer: (2) RPQS 

    :   ನ                                     

          ಸ  . '           '             ನ     

     ,     '           '                   .              

ಸ        RPQS. 

 

Q67.                                  . ಈ           

        '   '                ? 

(1)            

(2)         

(3)   ಸ      

(4)          

Answer: (3)          

    : '   '                /    ಸ               .  ನ   

                       ಸ             ಸ     .        

        ಸ    . 

 

Q68. ಈ                                 ? 

(1)    -       

(2)     -     

(3)    -     
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(4)     - ಸ    

Answer: (4)     -      

    : ಸ                                        

ಸ                  ಸ  . '   '        /   ; 'ಸ   '    . 

                ಸ            . 

 

Q69.                              . 

(1)                        

(2)        ಸ 

(3)              

(4)    ಸ        ಸ  

Answer: (3)              

    :        ನ         ,                            . 

'            '      / ನ                       

       .           ಈ    ನ                . 

 

Q70. ಈ                                  

         ? 

(1)        -        

(2)                  -      ಸ 

(3)            -       

(4)           ನ     -               

Answer: (4)                 -               

    :  ನ                          .                 , 

     ಸ                    ,      ನ                  

      .            ಸ    ;               . 
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Section III: Computer Knowledge - English Version (Q71-Q100) 

Q71. Match the MS Word shortcut keys with their actions: A. Ctrl + Shift + L, B. Ctrl + E, C. Ctrl + 

Shift + >, D. Ctrl + Shift + < 

(1) A-1, B-4, C-3, D-2 

(2) A-4, B-3, C-2, D-1 

(3) A-3, B-2, C-4, D-1 

(4) A-1, B-2, C-3, D-4 

Answer: (4) A-1, B-2, C-3, D-4 

Explanation: Ctrl+Shift+L applies bullet points; Ctrl+E gives centre alignment; Ctrl+Shift+> increases 

font size; Ctrl+Shift+< decreases font size. Therefore the correct matching is A-1, B-2, C-3, D-4. 

 

Q72. Which of the following formulas in MS Excel can be used to find the nth largest value in a 

range? 

(1) =LARGE(A1:A10, n) 

(2) =MAX(A1:A10, n) 

(3) =RANK(A1:A10, n) 

(4) =VLOOKUP(n, A1:A10, 1, FALSE) 
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Answer: (1) =LARGE(A1:A10, n) 

Explanation: The LARGE function returns the kth or nth largest value in a data range. MAX returns 

only the single largest value, RANK gives relative rank, and VLOOKUP searches vertically. Therefore 

LARGE(range,n) is correct. 

 

Q73. The ______ function returns the smallest value in a range that meets multiple criteria, whereas 

the ______ function returns the largest value in a range that meets multiple criteria in MS Excel. 

(1) SMALLIFS, LARGEIFS 

(2) MIN, MAX 

(3) MINIFS, MAXIFS 

(4) IFMIN, IFMAX 

Answer: (3) MINIFS, MAXIFS 

Explanation: MINIFS returns the minimum value among cells that satisfy one or more criteria. 

MAXIFS similarly returns the maximum value among cells that satisfy criteria. Hence MINIFS and 

MAXIFS form the correct pair. 

 

Q74. How do you apply double line spacing to a paragraph? 

(1) Home > Line and Paragraph Spacing > 2.0 

(2) Layout > Line Spacing > 2.0 

(3) Design > Line Spacing 

(4) Insert > Line Spacing > 2.0 

Answer: (1) Home > Line and Paragraph Spacing > 2.0 

Explanation: In MS Word, paragraph spacing commands are available in the Home tab under Line and 

Paragraph Spacing. Selecting 2.0 applies double spacing. Other tabs are not the standard path for this 

command. 

 

Q75. Consider the statements: Statement 1: The Home tab in PowerPoint contains options to insert 

text and images. Statement 2: The Insert tab is used for adding elements like charts, tables and 

pictures. 

(1) Both statements are correct 

(2) Only Statement 1 is correct 

(3) Only Statement 2 is correct 

(4) Both statements are incorrect 

Answer: (3) Only Statement 2 is correct 

Explanation: The Insert tab is specifically used to add pictures, charts, tables, shapes and other objects. 

The Home tab mainly contains clipboard, slides, font, paragraph and drawing basics; it is not the 



 

 www.infiniteiaskas.com    26 
 

principal tab for inserting images/charts. Thus only Statement 2 is correct. 

 

Q76. In Microsoft PowerPoint, themes can be found under ______. 

(1) Design tab 

(2) Transition tab 

(3) Insert tab 

(4) Animation tab 

Answer: (1) Design tab 

Explanation: PowerPoint themes are design packages containing colours, fonts and effects. They are 

available under the Design tab. Transitions and animations control movement, while Insert is used for 

adding objects. 

 

Q77. The ______ keyboard shortcut is used to insert a new comment in the existing presentation 

slide. 

(1) Ctrl+Alt+M 

(2) Shift+Alt+M 

(3) Ctrl+Shift+M 

(4) Shift+M 

Answer: (1) Ctrl+Alt+M 

Explanation: In recent Microsoft Office applications, Ctrl+Alt+M is used for inserting a new comment. 

Ctrl+Shift+M is commonly associated with slide-related functions, so it is a common distractor. 

 

Q78. Identify which of the following is not the primary role of an operating system. 

(1) Process management 

(2) Database management 

(3) File management 

(4) Memory management 

Answer: (2) Database management 

Explanation: An operating system manages processes, memory, files and devices. Database 

management is performed by database management systems such as MySQL, Oracle or MS Access, not 

by the operating system as a primary role. 

 

Q79. Statement 1: Styles in MS Word can be used to ensure consistent formatting throughout a 

document. Statement 2: Styles can only be applied to headings and not to regular paragraphs or 

other elements. 

(1) Both statements are true 
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(2) Both statements are false 

(3) Statement 1 is true and Statement 2 is false 

(4) Statement 1 is false and Statement 2 is true 

Answer: (3) Statement 1 is true and Statement 2 is false 

Explanation: Styles ensure consistent formatting and are useful for headings, normal paragraphs, lists, 

captions and many other elements. Therefore Statement 1 is true. Statement 2 is false because styles are 

not limited to headings. 

 

Q80. ______ is used to create personalized letters for multiple recipients. 

(1) Index 

(2) Table of contents 

(3) Mail Merge 

(4) Document Map 

Answer: (3) Mail Merge 

Explanation: Mail Merge combines a standard document with a data source to generate personalized 

letters, labels, envelopes or emails for multiple recipients. Index and table of contents are 

navigation/reference tools. 

 

Q81. To apply a header or footer that appears on every page of a Word document, you use the 

______ tab and select ______. 

(1) Layout, Header and Footer 

(2) Insert, Header and Footer 

(3) Design, Page Numbers 

(4) Page Layout, Header 

Answer: (2) Insert, Header and Footer 

Explanation: Headers and footers are inserted through the Insert tab in MS Word. The Header and 

Footer command places repeated content at the top or bottom of pages. Therefore the correct path is 

Insert > Header and Footer. 

 

Q82. The smallest unit of data in a computer is ______ and ______ is a program that protects a 

computer from viruses. 

(1) Bit, Antivirus 

(2) Byte, Operating System 

(3) Nibble, Antivirus 

(4) Giga Byte, Firmware 

Answer: (1) Bit, Antivirus 
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Explanation: A bit is the smallest unit of data and can represent 0 or 1. Antivirus software is designed to 

detect, prevent and remove malware or viruses. Hence 'Bit, Antivirus' is correct. 

 

Q83. Choose True or False respectively: Statement 1: A mouse is an input device. Statement 2: RAM 

is a nonvolatile memory. 

(1) True, True 

(2) True, False 

(3) False, True 

(4) False, False 

Answer: (2) True, False 

Explanation: A mouse is an input device because it sends user commands to the computer. RAM is 

volatile memory; it loses stored data when power is switched off. Therefore the statements are True and 

False respectively. 

 

Q84. Which of the following controls the degree of multiprogramming in the operating system? 

(1) Multiplexer 

(2) Dispatcher 

(3) Long-term scheduler 

(4) Medium-term scheduler 

Answer: (3) Long-term scheduler 

Explanation: The long-term scheduler decides how many processes are admitted into the ready queue 

from the job pool. By controlling the number of processes in memory, it controls the degree of 

multiprogramming. 

 

Q85. In Windows operating system, the maximize, minimize and close buttons of any window appear 

on ______. 

(1) Title bar 

(2) Tool bar 

(3) Menu bar 

(4) Status bar 

Answer: (1) Title bar 

Explanation: Window control buttons - minimize, maximize/restore and close - are placed on the title 

bar of a window. The title bar also shows the document or application name. 

 

Q86. Statement 1: CC recipients are hidden from other recipients. Statement 2: BCC recipients are 

visible to all recipients. 
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(1) Statement 1 is correct, whereas Statement 2 is incorrect 

(2) Statement 1 is incorrect, whereas Statement 2 is correct 

(3) Both Statement 1 and Statement 2 are correct 

(4) Both Statement 1 and Statement 2 are incorrect 

Answer: (4) Both Statement 1 and Statement 2 are incorrect 

Explanation: CC recipients are normally visible to all recipients. BCC recipients are hidden from other 

recipients. Therefore both statements as printed are incorrect. 

 

Q87. Which option is used to create a drop cap? 

(1) Home > Drop Cap 

(2) Insert > Drop Cap 

(3) Layout > Drop Cap 

(4) Design > Drop Cap 

Answer: (2) Insert > Drop Cap 

Explanation: A drop cap is a large initial letter at the beginning of a paragraph. In MS Word, it is 

inserted from the Insert tab using the Drop Cap option. Hence option (2) is correct. 

 

Q88. An email signature is typically placed at the ______ of an email. 

(1) Beginning 

(2) Middle 

(3) End 

(4) None of the above 

Answer: (3) End 

Explanation: An email signature usually appears at the end of an email after the message body. It 

commonly includes name, designation, contact details and organisation information. 

 

Q89. Which network topology is most susceptible to single point of failure? 

(1) Bus 

(2) Ring 

(3) Mesh 

(4) Star 

Answer: (4) Star 

Explanation: In star topology all nodes connect to a central hub or switch. If this central device fails, the 

network can fail for all connected nodes. Therefore star topology has a prominent single point of failure. 

 



 

 www.infiniteiaskas.com    30 
 

Q90. Fill in the blanks: Statement 1: The primary function of a ______ is to index web pages for 

search engines. Statement 2: A ______ is a software application used to access and view web pages. 

(1) Web Crawler, Web Browser 

(2) Web Browser, Web Crawler 

(3) Boot Loader, Web Crawler 

(4) Operating System, Web Browser 

Answer: (1) Web Crawler, Web Browser 

Explanation: A web crawler automatically visits and indexes web pages for search engines. A web 

browser such as Chrome, Edge or Firefox is used to access and view web pages. Hence the correct pair is 

Web Crawler and Web Browser. 

 

Q91. ______ address changes automatically and is assigned by a DHCP server. 

(1) Static IP 

(2) Dynamic IP 

(3) MAC 

(4) Both Static and Dynamic IP 

Answer: (2) Dynamic IP 

Explanation: A dynamic IP address is automatically assigned by a DHCP server and may change over 

time. A static IP is manually configured and normally remains fixed. 

 

Q92. ______ is used for accessing web-based email services whereas ______ is used to send emails to 

a mail server. 

(1) FTP, IMAP 

(2) DNS, FTP 

(3) NTP, IMAP 

(4) HTTP, SMTP 

Answer: (4) HTTP, SMTP 

Explanation: Webmail services are accessed through HTTP/HTTPS in a browser. SMTP, Simple Mail 

Transfer Protocol, is used for sending emails to or between mail servers. Therefore HTTP and SMTP are 

correct. 

 

Q93. Which of the following techniques is used to disguise the sender's identity in an email? 

(1) Sniffing 

(2) Spying 

(3) Spoofing 

(4) Decrypting 

Answer: (3) Spoofing 
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Explanation: Email spoofing is the act of forging sender information so that a message appears to come 

from someone else. It is commonly used in phishing and fraud. Sniffing captures network packets, while 

decrypting converts encrypted data into readable form. 

 

Q94. Which of the following is the correct sequence of the computer's data processing cycle? 

(1) Input, Output, Processing, Storage 

(2) Input, Processing, Output, Storage 

(3) Processing, Input, Output, Storage 

(4) Storage, Input, Processing, Output 

Answer: (2) Input, Processing, Output, Storage 

Explanation: The basic data processing cycle begins with input, then processing, then output, and finally 

storage of results for future use. Hence the correct sequence is Input -> Processing -> Output -> Storage. 

 

Q95. Select the correct set of input devices when A, B, C, D are the given sets. A: Keyboard, Scanner, 

Speaker, Joystick. B: Joystick, Touchscreen, Mouse, Microphone. C: Mouse, Scanner, Light Pen, 

Web Camera. D: Keyboard, Plotter, Monitor, Speaker. 

(1) A, B 

(2) B, C 

(3) C, D 

(4) A, D 

Answer: (2) B, C 

Explanation: Input devices send data or commands to the computer. Set B contains only input devices: 

joystick, touchscreen, mouse and microphone. Set C also contains input devices: mouse, scanner, light 

pen and web camera. Sets A and D contain output devices such as speaker, plotter and monitor. 

 

Q96. Statement 1: A compiler translates high-level language code into machine code. Statement 2: 

An interpreter translates high-level language code line by line. 

(1) Only Statement 1 is true 

(2) Only Statement 2 is true 

(3) Both Statements 1 and 2 are true 

(4) Neither Statement 1 nor Statement 2 is true 

Answer: (3) Both Statements 1 and 2 are true 

Explanation: A compiler translates an entire program into machine code or an intermediate form before 

execution. An interpreter reads, translates and executes code line by line. Thus both statements are true. 
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Q97. Which function in MS Excel searches for a value in the first row of a table and returns a value 

in the same column from a specified row? 

(1) VLOOKUP 

(2) HLOOKUP 

(3) INDEX 

(4) MATCH 

Answer: (2) HLOOKUP 

Explanation: HLOOKUP stands for Horizontal Lookup. It searches for a value in the first row of a table 

and returns a value from a specified row in the same column. VLOOKUP searches vertically in the first 

column. 

 

Q98. Pivot Tables and Pivot Charts are used in MS Excel for ______ and ______. 

(1) Filtering data; sorting data 

(2) Creating data entry forms; automating data entry 

(3) Creating dashboards; managing large data sets 

(4) Summarizing data; visualizing summarized data 

Answer: (4) Summarizing data; visualizing summarized data 

Explanation: Pivot Tables summarize large datasets by categories, totals, counts and other aggregations. 

Pivot Charts provide visual representation of those summaries. Therefore they are used for summarizing 

data and visualizing summarized data. 

 

Q99. TCP is a ______ protocol, UDP is a ______ protocol. 

(1) Connectionless, Connection oriented 

(2) Connection oriented, Connection oriented 

(3) Connection oriented, Connectionless 

(4) Connectionless, Connectionless 

Answer: (3) Connection oriented, Connectionless 

Explanation: TCP establishes a connection and provides reliable, ordered delivery, so it is connection-

oriented. UDP does not establish a connection and is faster but less reliable, so it is connectionless. 

 

Q100. The process of breaking down data into smaller packets for transmission over a network is 

called ______. 

(1) Segmentation 

(2) Encapsulation 

(3) Multiplexing 

(4) Framing 

Answer: (1) Segmentation 
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Explanation: Segmentation breaks large data into smaller segments or packets for transmission across a 

network. Encapsulation adds headers/trailers, multiplexing combines signals, and framing works mainly 

at the data-link layer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Section IV:           -           (Q71-Q100) 

Q71. MS Word                                : A. Ctrl + Shift + 

L, B. Ctrl + E, C. Ctrl + Shift + >, D. Ctrl + Shift + < 

(1) A-1, B-4, C-3, D-2 

(2) A-4, B-3, C-2, D-1 

(3) A-3, B-2, C-4, D-1 

(4) A-1, B-2, C-3, D-4 

Answer: (4) A-1, B-2, C-3, D-4 
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    : Ctrl+Shift+L               ನ      . Ctrl+E      /     

         . Ctrl+Shift+>                         Ctrl+Shift+<        

         .        A-1, B-2, C-3, D-4 ಸ         . 

 

Q72. MS Excel                 n                       

                ? 

(1) =LARGE(A1:A10, n) 

(2) =MAX(A1:A10, n) 

(3) =RANK(A1:A10, n) 

(4) =VLOOKUP(n, A1:A10, 1, FALSE) 

Answer: (1) =LARGE(A1:A10, n) 

    : LARGE                    k      n         

             . MAX                             ; RANK 

              ; VLOOKUP                 .        

LARGE(A1:A10,n) ಸ       . 

 

Q73. MS Excel                                           

______           ;                      ______           . 

(1) SMALLIFS, LARGEIFS 

(2) MIN, MAX 

(3) MINIFS, MAXIFS 

(4) IFMIN, IFMAX 

Answer: (3) MINIFS, MAXIFS 

    : MINIFS                                       ನ 

                  . MAXIFS                         

       ನ                   .        MINIFS, MAXIFS ಸ       . 

 

Q74.                                           ? 

(1) Home > Line and Paragraph Spacing > 2.0 

(2) Layout > Line Spacing > 2.0 

(3) Design > Line Spacing 

(4) Insert > Line Spacing > 2.0 

Answer: (1) Home > Line and Paragraph Spacing > 2.0 

    : MS Word ನ                           Home tab ನ        . Line 
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and Paragraph Spacing       2.0                      ನ      . 

 

Q75.     1: PowerPoint   Home tab                                

     .     2: Insert tab     charts, tables     pictures              

      . 

(1)           ಸ     

(2)     1     ಸ     

(3)     2     ಸ     

(4)                 

Answer: (3)     2           

    : PowerPoint ನ        ,      ,                         ಸ  

Insert tab         ಸ     . Home tab       clipboard, slide, font, paragraph 

                         .            2     ಸ    . 

 

Q76. Microsoft PowerPoint     themes    tab            ? 

(1) Design tab 

(2) Transition tab 

(3) Insert tab 

(4) Animation tab 

Answer: (1) Design tab 

    : Themes      presentation      , font     effect    ಸ       ಸ. PowerPoint 

ನ   themes   ನ    Design tab             . 

 

Q77.     presentation slide        comment         keyboard shortcut 

        ? 

(1) Ctrl+Alt+M 

(2) Shift+Alt+M 

(3) Ctrl+Shift+M 

(4) Shift+M 

Answer: (1) Ctrl+Alt+M 

    : Microsoft Office ನ  ಸ          comment   ಸ  Ctrl+Alt+M shortcut 

        . Ctrl+Shift+M slide                              

          . 
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Q78.               operating system              ? 

(1) Process management 

(2) Database management 

(3) File management 

(4) Memory management 

Answer: (2) Database management 

    : Operating system      ,    ,           ನ             . 

Database management   ಸ    DBMS            ;    OS ನ    ನ       . 

 

Q79.     1: MS Word     Styles                    formatting 

         .     2: Styles     headings                 ; 

     paragraph                             . 

(1)           ಸ  

(2)               

(3)     1 ಸ ,     2     

(4)     1    ,     2 ಸ  

Answer: (3)     1   ,     2     

    : Styles      ನ formatting           ಸ  ಸ        ; 

           1 ಸ . Styles headings         normal paragraphs, lists, captions 

          ನ  ಸ   ;            2    . 

 

Q80.                                    ______         . 

(1) Index 

(2) Table of contents 

(3) Mail Merge 

(4) Document Map 

Answer: (3) Mail Merge 

    : Mail Merge ನ                  data source                     

          /   /       ಸ   .        Mail Merge ಸ        . 

 

Q81. Word document                    header     footer        

    ______ tab     ______         . 

(1) Layout, Header and Footer 

(2) Insert, Header and Footer 
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(3) Design, Page Numbers 

(4) Page Layout, Header 

Answer: (2) Insert, Header and Footer 

    : MS Word ನ   header     footer          Insert tab ನ        . Header and 

Footer                  /                           . 

 

Q82. Computer     data              ______     virus      computer       

program ______. 

(1) Bit, Antivirus 

(2) Byte, Operating System 

(3) Nibble, Antivirus 

(4) Giga Byte, Firmware 

Answer: (1) Bit, Antivirus 

    : Bit                             0     1           . 

Antivirus program virus/malware                    ಸ        .        Bit, 

Antivirus ಸ       . 

 

Q83.     1: Mouse     input device.     2: RAM non-volatile memory.       

True/False      . 

(1) True, True 

(2) True, False 

(3) False, True 

(4) False, False 

Answer: (2) True, False 

    : Mouse                  computer         input device    . RAM 

volatile memory;                 ನ data       .        True, False 

ಸ        . 

 

Q84. Operating system     multiprogramming                    ? 

(1) Multiplexer 

(2) Dispatcher 

(3) Long-term scheduler 

(4) Medium-term scheduler 

Answer: (3) Long-term scheduler 



 

 www.infiniteiaskas.com    38 
 

    : Long-term scheduler job pool         process      memory/ready queue   

                 . ಈ     memory       process                

     ;    multiprogramming    . 

 

Q85. Windows operating system         window   maximize, minimize     close 

buttons               ? 

(1) Title bar 

(2) Tool bar 

(3) Menu bar 

(4) Status bar 

Answer: (1) Title bar 

    : Window             title bar ನ   window  ಸ     minimize, 

maximize/restore     close buttons      .        Title bar ಸ        . 

 

Q86.     1: CC                                 .     2: BCC 

                                 . 

(1)     1 ಸ ,     2     

(2)     1    ,     2 ಸ  

(3)           ಸ  

(4)               

Answer: (4)               

    : Email ನ   CC ನ           ನ                  . BCC ನ   

                  .                       . 

 

Q87. Drop Cap                        ? 

(1) Home > Drop Cap 

(2) Insert > Drop Cap 

(3) Layout > Drop Cap 

(4) Design > Drop Cap 

Answer: (2) Insert > Drop Cap 

    :                        Drop Cap           . MS Word 

ನ   Drop Cap     Insert tab             . 
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Q88. Email signature        email                 ? 

(1)     

(2)     

(3)      

(4)   ನ         

Answer: (3)      

    : Email signature   ನ                    .        ಸ ,    , 

                                 . 

 

Q89. Single point of failure                network topology    ? 

(1) Bus 

(2) Ring 

(3) Mesh 

(4) Star 

Answer: (4) Star 

    : Star topology ನ       nodes central hub/switch              .   central 

device             network               .        Star topology 

single point of failure              . 

 

Q90.             : Search engines    web pages index     primary function 

       ______. Web pages access     view          software application 

______. 

(1) Web Crawler, Web Browser 

(2) Web Browser, Web Crawler 

(3) Boot Loader, Web Crawler 

(4) Operating System, Web Browser 

Answer: (1) Web Crawler, Web Browser 

    : Web Crawler search engines    webpages           index      . Web 

Browser webpages     ಸ       software.        Web Crawler, Web Browser ಸ    

   . 

 

Q91. DHCP server                                   

address ______. 

(1) Static IP 
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(2) Dynamic IP 

(3) MAC 

(4) Static     Dynamic     

Answer: (2) Dynamic IP 

    : Dynamic IP address DHCP server     ಸ                      

               . Static IP   ನ              . 

 

Q92. Web-based email services access     ______         ; mail server   emails 

      ______         . 

(1) FTP, IMAP 

(2) DNS, FTP 

(3) NTP, IMAP 

(4) HTTP, SMTP 

Answer: (4) HTTP, SMTP 

    : Browser     webmail            ಸ  HTTP/HTTPS   ಸ     . 

Email    ಸ  SMTP         .        HTTP, SMTP ಸ        . 

 

Q93. Email     sender identity          /               technique 

   ? 

(1) Sniffing 

(2) Spying 

(3) Spoofing 

(4) Decrypting 

Answer: (3) Spoofing 

    : Spoofing ನ             ಸ/      ನ             ಸ     . 

Phishing     cyber fraud           ನ           . 

 

Q94. Computer data processing cycle               ? 

(1) Input, Output, Processing, Storage 

(2) Input, Processing, Output, Storage 

(3) Processing, Input, Output, Storage 

(4) Storage, Input, Processing, Output 

Answer: (2) Input, Processing, Output, Storage 

    : Data processing cycle   ನ    Input           Processing,     Output 
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          Storage            .        Input -> Processing -> Output -> Storage 

ಸ       . 

 

Q95. A, B, C, D              Input Devices                :  

A: Keyboard, Scanner, Speaker, Joystick.  

B: Joystick, Touchscreen, Mouse, Microphone.  

C: Mouse, Scanner, Light Pen, Web Camera.  

D: Keyboard, Plotter, Monitor, Speaker. 

(1) A, B 

(2) B, C 

(3) C, D 

(4) A, D 

Answer: (2) B, C 

    : Input devices data/commands     computer          . B    ನ joystick, 

touchscreen, mouse, microphone      input devices. C    ನ mouse, scanner, light pen, web 

camera    input devices. A     D     speaker, plotter, monitor      output devices 

  . 

 

Q96.     1: Compiler high-level language code     machine code           . 

    2: Interpreter high-level language code     line by line         . 

(1)     1     ಸ  

(2)     2     ಸ  

(3)           ಸ  

(4)               

Answer: (3)              

    : Compiler      program     machine code     intermediate code   

        . Interpreter                                    . 

                 ಸ . 

 

Q97. MS Excel     table   first row     value        column   specified row   value 

            function    ? 

(1) VLOOKUP 

(2) HLOOKUP 

(3) INDEX 
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(4) MATCH 

Answer: (2) HLOOKUP 

    : HLOOKUP      Horizontal Lookup.    table ನ     row ನ   value    , 

   column ನ     row ನ value           . VLOOKUP column         

             . 

 

Q98. MS Excel     Pivot Tables     Pivot Charts     ______     ______    

        . 

(1) Data filter; data sort 

(2) Data entry forms    ; data entry automation 

(3) Dashboards    ; large data sets       

(4) Data summary; summarized data visualization 

Answer: (4) Data summary; summarized data visualization 

    : Pivot Table     data set     summary          ಸ        . Pivot 

Chart   summarized data     graph/chart              .        data summarize 

    visualization               . 

 

Q99. TCP     ______ protocol; UDP     ______ protocol. 

(1) Connectionless, Connection oriented 

(2) Connection oriented, Connection oriented 

(3) Connection oriented, Connectionless 

(4) Connectionless, Connectionless 

Answer: (3) Connection oriented, Connectionless 

    : TCP              reliable delivery       ,           connection-

oriented. UDP         ಸ  data        ,           connectionless. 

 

Q100. Network     data                packets           

         ______           . 

(1) Segmentation 

(2) Encapsulation 

(3) Multiplexing 

(4) Framing 

Answer: (1) Segmentation 

    : Segmentation ನ       data     network transmission            



 

 www.infiniteiaskas.com    43 
 

ಸ            ಸ     . Encapsulation headers      ; Multiplexing signals 

     ; Framing data-link layer          . 

 


